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CHAPTER 1 INTRODUCTION

PURPOSE of this MANUAL
This manual is a guide for users of Lyric and Asset Manager running on Graphics Preparation 
Workstations. 

This manual does not have operating instructions for the Newsroom Client or playout device 
software. These instructions are available in the appropriate Operators’ manuals. 

Java version numbers "1.6.0" and "6.0" 
appearing in this and related documentation are used 
to identify the release of the Java 2 Platform Standard 
Edition (J2SE). Version "6.0" is the product version, 
while "1.6.0" is the developer version.

MANUAL ORGANIZATION
Here is a quick overview of the chapters in the manual.

•  CHAPTER 1 INTRODUCTION - gives the purpose of this manual, its 
organization, and customer support information.

•  CHAPTER 2 OVERVIEW - provides a description of the Chyron MOS 
workflow.

•  CHAPTER 3 LYRIC - gives installation and configuration information and 
information on creating content.

•  CHAPTER 4 CAMIO ASSET MANAGER - describes the CAMIO Asset 
Manager.

•  APPENDIX A SETTING UP JAVA to ENABLE ASSET MANAGER 
OPERATION - gives the necessary information allowing Asset Manager to 
operate properly.

•  APPENDIX B GLOSSARY - contains terms users need to understand 
the CAMIO MOS System and its operation.

•  APPENDIX C CAMIO ASSET MANAGER (legacy) - describes the prior 
version of the CAMIO Asset Manager and gives installation instructions.

CUSTOMER SUPPORT
For customer support, call 1-888-4-CHYRON (1-888-424-9766).
Visit the Chyron Website at www.chyron.com, for immediate access to our forums and 
knowledge base, and an array of documentation downloads and other information to assist you.
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CHAPTER 2 OVERVIEW

INTRODUCTION
WORKFLOW 
The following briefly describes the Chyron MOS workflow. See Figure 1on page 7, and refer to the 
definitions provided below, while reading the following.

•  Messages (Templates) are created in an offline or online version of 
Lyric (with the XML plugin loaded).

•  Images and movies are created using applications like Adobe® 
Photoshop® and Adobe® After Effects®. 

•  Using Asset Manager, Messages, images, and movies are uploaded to 
the previously created Context that resides on the Chyron MOS Server. 

•  Once the content is uploaded, it is immediately available to the 
newsroom staff through the LUCI Newsroom Client plugin. All Context 
content can be managed using the Asset Manager.
6



Figure 1  WORKFLOW

SOME USEFUL DEFINITIONS 
•  Contexts are Groups of assets (Messages, also referred to as Templates, 

and images), for use in a Chyron MOS System. Individual Contexts are 
most commonly used to manage content of the same look. For example, 
two Contexts could be created to separate different look morning and 
evening news graphics. Contexts can also be used to manage users. If 
there is content that only specific users can have access to then this should 
also be located in a separate Context, since user privileges are assigned to 
whole Contexts.

•  Messages, for use in a Chyron MOS system, can be created on any 
version of Lyric (version 4.2 and above). Messages must have appropriate 
XML data associated with them. Lyric will automatically create this XML, if 
the XML plugin is loaded into the version of Lyric used to build the content. 
The XML plugin must be configured correctly. 

•  Images, for use in the Chyron MOS System, must have compatible image 
formats supported by Lyric (e.g., BMP, JPG, PNG, PSD, TGA, and TIF). 
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These images can be created (in any application) and uploaded to Asset 
Manager from a PC.

•  Movies, for use in the Chyron MOS System, must be in either avi or mov 
video format for compatibility with Lyric.These movies can be uploaded to 
Asset Manager from a PC.

•  Asset Manager is a Java based application that enables users to manage 
Chyron MOS Server content in a similar way that Windows Explorer is 
used to manage a computer’s content.

•  LUCI is used by the newsroom to browse for appropriate Template 
Description Messages and graphics for stories. Content uploaded to 
Contexts through Asset Manager is immediately available for use by the 
newsroom staff. Newsroom staff can search for content using metadata 
that was associated with content during the upload.
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CHAPTER 3 LYRIC

INTRODUCTION
Lyric and Lyric PRO Offline are powerful graphics packages with advanced animation creation, 
intelligent transitions and playout control. The new features for Lyric PRO version 7.0 include: 

•  Full 32-bit support of both QuickTime movies and .avi clips for fast creation 

•  Adaptable primitive geometry for fast creation of 3D objects 

•  FBX® Importer delivering unprecedented levels of interoperability with 
Autodesk® 3ds Max® and Maya® for Lyric PRO authoring environment, all 
while maintaining original polygon meshes, geometry hierarchy, lights, 
cameras and animations. 

INSTALLING LYRIC and ASSOCIATED TASKS
MINIMUM SYSTEM REQUIREMENTS
Before installing Lyric, be sure your system meets the following minimum requirements:

•  Windows® XP with Service Pack 2 or Windows Vista® operating system. If 
using Vista, then Lyric must either be RUN AS ADMIN, or USER 
ACCOUNT CONTROL must be set to OFF in order to have full 
functionality. Please note that RUN AS ADMIN provides greater security.

•  Intel® Core™ 2 Duo processor

•  nVidia® 8 or better series video card with minimum 512MB RAM

•  100GB drive space; physical or virtual drives should be configured to 
match the playout system to facilitate message and asset transfer.

•  2GB of RAM

•  Standard keyboard
10



INSTALLING LYRIC
ABOUT LYRIC SOFTWARE LICENSING

Important

Lyric 7 and the Lyric PRO option require the presence
of a Chyron-supplied dongle in the system in order to
run. Dongles that have enabled older versions of Lyric
on existing Chyron systems ARE NOT compatible with
Lyr ic  Vers ion  7 .  They  must  therefore  be
reprogrammed. Please contact Chyron Customer
Service at 631-845-2132 if you are upgrading a Chyron
system to Lyric Version 7. 

Before upgrading from Lyric Version 5.x to 6.x, contact 
Chyron Customer Service at 631-845-2132.

Newly-purchased Chyron systems include either Lyric Version 7 or the Lyric PRO option, as 
ordered by the customer, with the purchased options enabled. Therefore, no licensing updates are 
required.

•  To purchase and enable additional software options, please contact 
Chyron Customer Service. 

•  Newly purchased Lyric 7 Offline and Lyric PRO Offline packages include a 
dongle kit programmed with the appropriate options.

 Full instructions for upgrading a Chyron 
system running a previous version of Lyric to Lyric 7 
or Lyric 7 PRO may be found in the Lyric 7 Release 
Notes, Chyron Document Number 2A02249.

To install Lyric:
1. Insert the installation CD in your CD-ROM drive.

2. Locate and double-click the Lyric setup icon on the installation CD.

3. Click on Next.The Chyron Welcome screen is displayed (Figure 2). Read the information 
provided there. 
11



Figure 2  Chyron Lyric Welcome Screen

4. Click on Next. The Lyric License Requirements dialog box (Figure 3) 
appears.Click on Yes to continue with the installation.

Figure 3  Lyric License Requirements
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5. The License Agreement window (Figure 4).

Figure 4  License Agreement

6. After reading and accepting all the terms of the license, click on Yes. The Choose 
Destination Location window (Figure 5) is displayed.

Figure 5  Destination Folder
13



7. Click on Next to install Lyric in the selected folder, or click on Browse and select another 
folder. The Setup Type window (Figure 6) is displayed.

Figure 6  Setup Type

8. Select the type of setup you prefer:

•  Custom—select the features you want to install

•  First Time User—have sample content installed with Lyric

•  Minimal—install Lyric and minimum supporting DLLs

•  Server—typical installation, registers Lyric

•  Typical— if you do not require sample content
14



9. Click on Next. The Select Program Folder window (Figure 7) is displayed.

Figure 7  Select Program Folder

10. Select a program folder. Click on Next. Lyric is now installed.

11. After Lyric is installed, the SentineILM 6.2 Server Setup screen is displayed (Figure 8). 
Follow the on-screen instructions.

Figure 8  SentineILM Server Setup 
15



12. After installing the server, the Lyric Setup Complete screen is displayed (Figure 9).

Figure 9  Lyric Setup Complete

13. Click Finish to complete the setup.

14. Next, install the Lyric MOS XML plug-in. This will add XML tags to all Lyric Messages 
saved on that version of Lyric (existing messages will need to be re-saved to get the XML 
tag).

INSTALLING the LYRIC MOS XML PLUG-IN

Important

This plug-in needs to be installed on each version of 
Lyric that will be creating content that will be accessed 
by the Camio server. 

To enable Lyric on the playout device to interpret and act on the MOS and XML information it 
receives from the CAMIO Server, the Lyric MOS XML plug-in and the MSXML4 dll must be 
installed on the playout system. 

The installation of the MSXML4 dll is 
performed automatically and is transparent to the user.
16



To install the Lyric MOS XML plug-in:

Important

The CAMIO Server must already be installed on the 
network before you can install this plug-in.

1. Navigate to http://camioserver:8080/install.tsp, where camioserver is the name of the 
camio server.

2. Double-click on the Lyric MOSXML Plugin.exe icon.

3. The MOSXML Plug-in Welcome window (Figure 10) opens.

Figure 10  Welcome to Lyric MOS XML Plug-in Setup
17



4. Click Next. The Choose Destination window (Figure 11) opens.

Figure 11  Choose Destination

5. Select the folder where the files will be installed based on the version of Lyric that will be 
used on this system to compose new Lyric messages.

6. Click Next and follow the online instructions.

CREATING CONTENT
TEMPLATES
Lyric messages that will become Template Description Messages can be created in Lyric using 
the standard Lyric creation tools.

Refer to Lyric online Help or the Lyric 
manual located on the Chyron website, for complete 
information on creating messages. 

While Lyric software is installed on the CAMIO server, it is 
recommended that content not be created using Lyric on the CAMIO 

server.
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Image Objects and templated text fields can be updated by newsroom staff in LUCI, if so 
configured in Lyric.

UPDATEABLE TEMPLATES
As a default, all templates are updateable through LUCI. In LUCI the descriptive field is adopted 
from the name input field in the 2D text template menu (right click>template properties). The 
order in which the templates are offered in LUCI is adopted from the number field in the 2D Text 
Template menu. 

Templates should not be assigned a number of -1. LUCI Input field to 
Lyric Template correspondence can become unpredictable when there 

is a template or templates assigned -1 in the number field.

Templates can be constrained to display a maximum number of characters. This is useful for small 
templates. It ensures that newsroom staff do not over populate them with characters. 

To access this feature:

1.  Make the template active.

2. Right-click on the template and select MOS from the Context menu. The MOS Template 
Properties dialog (Figure 12) opens. 

Figure 12  MOS Template Properties Dialog

3. In the Maximum Characters panel click on the Enabled checkbox.

4. Enter the maximum number of characters allowed in the Maximum Character field. Users 
in LUCI will not be able to type more characters in their corresponding input field than is 
entered here. 

MAXIMUM CHARACTER FIELD
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Templates can be read only. 

To make a template read-only:

1.  Make the template active.

2. Right-click on the template and select MOS from the Context menu. The MOS Template 
Properties dialog (Figure 12) opens.

3. Disable the update function by selecting Yes from the Read Only drop-down list. Click 
OK.

Templates can be preview only—they will not display on output, but will be displayed on a LUCI 
preview. 

To enable this feature:

1. Make the template active.

2. Right-click on the template and select MOS from the Context menu. The MOS Template 
Properties dialog (Figure 12) opens.

3. Select Yes from the Preview Only drop-down list. Click OK.

CHANGING the LABEL of a TEXT FIELD
To change the label of a text field:

1. Select the template.

2. Right-click on the template and select Template Properties from the Context menu. The 
2D Text Template dialog appears (Figure 13).

Figure 13  2D Text Template Dialog
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UPDATEABLE IMAGES
Images are not automatically updateable through LUCI. To make an image updateable, it must 
have II Update selected in the 2D Object Properties. 

To make an image updateable:

1. Select the image

2. Right-click on it or its listing in the Scene Graph. 

3. Select 2D Object Properties from the context menu (Figure 14) that appears. 

Figure 14  Selecting 2D Object Properties

4. The 2D Object Template dialog is displayed (Figure 15). 

Figure 15  2D Object Template

5. Check II Update in the Optional panel (Figure 15).

II UPDATE
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PREVIEW ONLY
Images can be preview only—they will not display on output, but will be displayed on a LUCI 
preview. 

To enable this feature:

1. Right-click on an image. Select MOS from the context menu that appears. 

2. The CAMIO MOS Properties dialog appears (Figure16). Select Yes from the Preview 
Only list box.

3. .Click OK.

Figure 16  MOS Properties Dialog

4. Save the message with the image unchecked in the Scene Graph as shown in Figure 17.

Figure 17  Scene Graph—Image Unchecked

Some advanced effects will not animate correctly after an image has 
been substituted in LUCI. Chyron recommends that all Lyric 

description messages be tested prior to uploading to Contexts.
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UPDATEABLE MOVIES
Movies are not automatically updateable through LUCI. To make a movie updateable, it must have 
II Update selected in the Movies Properties dialog. This can be done either when a movie is first 
imported or after a movie has been imported.

To make a movie updateable when it is first imported:

1. Click on the Create a Movie Region icon. The Movies Properties dialog (Figure 18) 
appears.

2. Use the Browse button to locate the movie file.

3. Check the II Update check box (shown circled in Figure 18).

4. Click on OK.

Figure 18  Movie Properties Dialog—II Update Checked
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To make a movie updateable after it is imported:

1. In the Scene Graph, click on the movie you want to make updateable, and then right-click 
on it. The context menu is displayed. See Figure 19.

Figure 19  Selecting a Movie to Make Updateable

2. Select Show Movie Properties from the context menu. The Movie Properties dialog box 
is displayed (Figure 20).

Figure 20  Movie Properties Dialog—II Update Checked

3. Check the II Update checkbox as shown (circled) in Figure 20.

4. Click OK.
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CHANNEL ASSIGNMENTS
The Chyron MOS System enables the Administrator to quickly manage content to playout devices 
using virtual and physical channels. In short, a message is assigned a virtual channel in the design 
stage that is assigned to a physical channel of a playout device. This enables content to be routed 
quickly to different machines, if required.

Chyron recommends that a discussion between the production crew and the art department take 
place, to formulate the best assignment of content across available Chyron CG channels. Multiple 
virtual channels can be assigned a single physical channel. For example, lower thirds assigned 
channel A, OTS channel B, full screens channel C, and monitor wall channel D—these could then 
be assigned channel A to physical channel 1, channel B to physical channel 2, and channels C 
and D to physical channel 3. If a fourth physical channel becomes available, then channel D can 
be quickly assigned physical channel 4. 

In Lyric, you can assign a virtual channel for a message to play out.

There is no limit to the number of virtual 
channels that can be assigned. They may be any 
alphanumeric value, as long as they are configured in 
the Chyron MOS Admin Tools.

To assign a virtual channel:

1. In the Scene Graph, click on Global Light to select it.

2. Right-click to display the Context menu. Select MOS. The MOS Properties dialog (Figure 
21) is displayed.

3. On the General tab, assign a virtual channel (usually A, B, C, or D) by entering it in the 
Channel field. This channel assignment can be overridden in LUCI.

4. Click on OK.

Figure 21  MOS Properties Dialog—General Tab
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SNAP FRAMES 
If a Template Description Message animates, it may be required to create a preview frame for 
LUCI that is not the first frame of the message. A new frame, called a Snap frame, can be 
assigned. Currently only one snap frame is supported.

To assign a Snap frame:

1. In the Scene Graph, click on Global Light to select it. 

2. Right-click to display the Context menu. Select MOS. The MOS Properties dialog is 
displayed. 

3. Select the Snap Frame tab (Figure 22). 

4. Move the pointer to the desired frame. Click on Preview to view the preview frame.

5. Click on OK.

Figure 22  MOS Properties Dialog—Snap Frame Tab

When a Template Description Message is uploaded to the Context on 
the Chyron MOS Server, the messages and images are automatically 
transferred to the playout device. However, if a message contains a 
clip, unembedded images, flipbooks, or 3D text images this content 

must be transferred to the output machines manually. It is 
recommended that this content be sent to all machines. If a channel is 
assigned to a new device, it will require all the content to be local to the 

new device. Ensure that this content is at the same location where it 
was when created. 
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SAVING a TEMPLATE INTO CAMIO
To save a template into Camio:

1. From the Lyric Main menu, select File>Save To Camio (Figure 23). The Save To Camio 
dialog (Figure 24) is displayed.

Figure 23  Save To Camio Menu Selection

Figure 24  Save To Camio Dialog

2. Enter the name of the Camio server you want to connect to in the Camio Server field.

3. Select a Context from the Context drop-down list by clicking on the arrow next to the 
Context box and selecting a Context from the list.

4. Select a path from the Path drop-down list by clicking on the arrow next to the Path box 
and selecting a path from the list.
27



5. Enter a filename for the template in the Filename field. IF no file name is entered, the 
Lyric file name (ex: 12345678.lyr) becomes the title.

6. You may enter metadata in the Author, Title, Comments, Keywords, and Subject fields 
provided in the Metadata panel.

7. When finished, click on OK.

You can also save templates to Camio using the Asset Manager. See 
“WORKING in ASSET MANAGER” on page 61.
28



NOTES:
29



CHAPTER 4 CAMIO ASSET MANAGER

OVERVIEW
The Asset Manager is a powerful tool in CAMIO for managing graphics and Lyric Templates (also 
referred to as assets). Assets can be viewed, sorted, edited, copied, deleted, and downloaded. A 
virtual folder hierarchy enables simple, yet sophisticated organization.

TWO VERSIONS
Two versions of Camio Asset Manager are currently supported. The latest version is described in 
this chapter. The prior version is described in “APPENDIX D: CAMIO LEGACY ASSET 
MANAGER” on page 56.

The new Asset Manager requires no JAVA Permissions to download assets, and it supports the 
new replication function.

INITIAL LAUNCH of ASSET MANAGER
The initial launch of Asset Manager will install the latest version of Java, but not if Java 1.4 (or 
earlier) is already installed. The older version of Java must first be uninstalled. 

Check if there is an older version of Java installed on the client PC. 

To do this:

1. Open the Windows Control Panel. Double-click on Add or Remove Programs. The Add 
or Remove Programs dialog displays.

2. Check that the version of the Java Runtime currently installed is Java SE 6 Update 10. If it 
is not, remove it

To open Asset Manager:

Asset Manager must already be configured, and the Service Broker 
must be running to successfully open Asset Manager.

1. Open Internet Explorer.

2. Enter the following URL: http://camioserver:8080/assetmanager (8080 is the data 
connection port used by CAMIO and camioserver is the name of the Chyron MOS 
server). The CAMIO Server automatically loads the Java Runtime.

3. Next, set up Java to ensure Asset Manager operation. See “ADDITIONAL NOTES” on 
page 45.
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4. Click Enter or Go. The Login window is displayed (Figure 25).

Figure 25  Camio Asset Manager Login Window

5. Enter Host Name.

6. Leave Port Number as 93.

7. Enter admin in the User Name field and admin in the Password field.

8. Click OK. The Asset Manager is displayed (Figure 26).

Figure 26  Camio Asset Manager
31



 ASSET MANAGER INTERFACE
The Asset Manager Interface (Figure 27) consists of a Server/Context window, an Asset Display 
window, and an area where files may be dropped and entered into Asset Manager.:

Figure 27  ASSET MANAGER INTERFACE

Server/Context Window (Figure 28) - displays the various servers on the system, Context icons, 
and any Context sub-folders.

Figure 28  Server/Context Window

SERVER/CONTEXT
ASSET DISPLAY WINDOWWINDOW

DROP NEW FILES HERE
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A plus sign to the left of the Context icon indicates that there are sub-folders in that Context. 
Clicking on the plus sign will expand the view and allow you to browse the sub-folders. 

When a new Context is created in CAMIO, there is only a Context Icon and a Trash container 
within the context. Sub-folders for the assets used in a context are not required. It is suggested, 
however, that a folder hierarchy such as

- Messages

- Images

be created to provide a visual structure for publishing and searching for assets on the system.

Asset Display Window (Figure 29) - displays Context assets. Note that assets with Alpha 
channels display a checkerboard background.

Figure 29  Asset Display Window

Right-clicking on the Asset Display Window displays a context menu (Figure 30) whose menu 
items you can use to:

•  change icon size

•  switch to thumbnail view

•  refresh display

•  set which columns are displayed 

Figure 30  Asset Display Window—Context Menu
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Refresh Display, Change Icon Size, Switch to Thumbnail View

To refresh the display or change icon size or switch to the thumbnail view, simply select the 
desired menu item. 

Selecting Show Small Icons from the context menu changes the display to appear as shown in 
Figure Figure 31).

Figure 31  Small Icons

Selecting Show Large Icons from the context menu changes the display to appear as shown in 
Figure Figure 32 ).

Figure 32  Large Icons
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Selecting Show Thumbnail View from the context menu changes the display to appear as shown 
in Figure 33).

Figure 33  Thumbnail View

Set Columns

To set which columns (metadata fields) are displayed, select Set Columns from the context 
menu. The Show Metadata Fields dialog (Figure 34) is displayed.

Figure 34  Show Metadata Fields Dialog

To add one or more fields, select the desired field(s) from the window on the left and click Add. To 
remove one or more fields, select the desired field(s) to remove from the window on the right, and 
then click Remove.
35



WORKING in ASSET MANAGER
ENTERING FILES
In the following procedures, you will be uploading files to Asset Manager.

ENTERING FILES ONE at a TIME
To enter a file:

1. Any file type can be entered in Asset Manager. Simply drag and drop the file onto the 
indicated area (Figure 35). 

Figure 35  Entering Assets
2. After dropping the new file in the indicated area, the New Asset Details dialog (Figure 36) 

is displayed. Use this dialog to enter meaningful metadata about the asset in the Subject, 
Keywords, and Comments fields. 

Important

It is important that meaningful metadata is entered to facilitate 
searching the asset database at a later time.   Asset Manager has a 
search tool that allows you to search for files using this metadata. The 
metadata is also used by the newsroom to conduct searches in LUCI.

Figure 36  New Asset Details Dialog

DROP NEW FILES HERE
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ENTERING MORE THAN ONE ASSET at a TIME
To enter files:

1. Use Ctrl + click to select multiple files and drag and drop them onto the indicated area in 
Asset Manager. The New Asset Details dialog (Figure 37) is displayed. 

Figure 37  New Asset Details—Use as Template For All Files

2. Enter meaningful metadata about the files in the Subject, Keywords, and Description 
fields.

3. Check the Use As Template For All Files checkbox (applies the metadata you enter to all 
selected files), or leave it unchecked (allows you to enter metadata separately for each of 
the selected files). 

4. Click on Upload.

5. If you checked Use As Template For All Files, click Upload. All selected files will be 
uploaded; you may now exit this procedure. If you did not check Use As Template For All 
Files, proceed to step 6.

6.  When done entering metadata for the first selected file, click on Upload. 

7. Enter metadata for the next selected file. Click on Upload. Repeat step 6 and step 7 until 
all the files have been uploaded.
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STORING IMAGE FILES and LYRIC TEMPLATES
Asset Manager handles the storing of image files and Lyric Templates as follows:

Image Files
An image file will generate a thumbnail image when entered into Asset Manager. These 
thumbnail images will also be displayed in LUCI’s Image Browser when the applicable Context 
is selected.

Lyric Templates
To use Lyric templates in LUCI, they must have been previously saved with XML. See Saving 
Lyric Templates with XML, below. Asset Manager will report an error in the Status Window, if 
you try to store a .lyr file that does not have XML in it.

SAVING LYRIC TEMPLATES with XML
In order to enter Lyric templates into Asset Manager, they must have been previously saved with 
XML. To do this, save the template in Lyric. Lyric must be running on a template creation 
workstation that has the XML and MOS plug-ins installed and configured correctly.

The template creation workstation can be an offline Lyric system or a 
Duet system. The template creation workstation should not be on the 

CAMIO server. 

CONTEXTS
Clicking on a Context icon will display all the assets in the Asset Display window. A plus sign to the 
left of the Context icon (Figure 38) indicates that there are sub-folders in that Context. Clicking on 
the plus sign will expand the view and allow you to browse the sub-folders. 

Figure 38  Click to View Subfolders

CLICK TO
EXPAND
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CONTEXT SUBFOLDERS
Using Context subfolders offers a convenient way to organize different types of assets within a 
Context. It is recommended to create and name folders that match the content that will be 
uploaded.

Adding a New Folder

To add a new folder:

1. Right-click on the Context. 

2. Select New Folder from the context menu that appears. The dialog shown in Figure 39 
appears. 

Figure 39  Create Folder

3. Enter the name of the new folder. 

4. Click OK.

To use Lyric templates in LUCI, they must have been previously saved with XML. Asset Manager 
will report an error in the Status window if you try to store a .lyr file that does not have XML in it.

DELETING OBJECTS
To delete an object from a Context, right-click on the object and select Delete. The object will then 
be moved into the Trash bin, and may be deleted from there. To delete the contents of the Trash 
bin, right-click on the Trash bin and select Empty Trash.

To delete an object without moving it to the Trash bin, hold down the Shift key, while performing 
the delete operation. This operation cannot be undone.
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VIEWING/EDITING OBJECT PROPERTIES
Object properties can be viewed/edited once an object has been uploaded by right-clicking on the 
object and selecting Properties from the context menu. The Properties dialog appears with the 
General tab selected by default. See Figure 40. The Properties dialog allows edits to be made to 
the metadata as well as offering the ability to change Virtual channel assignments and snap 
frames. See below for detailed descriptions of these tabs. 

General Tab (Figure 40) - The General tab displays the Lyric message number, type of file, 
Lyric build number, and other pertinent file information including if files were saved with XML 
(see Attributes).

Figure 40  Properties—General Tab
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Summary Tab (Figure 41) - The Summary tab provides Title, Subject, Author, Keywords, 
and Description fields that may be edited.

Figure 41  Properties Dialog—Summary Tab
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MOS Tab (Figure 42) - The MOS tab provides various fields for editing.

Figure 42  Properties Dialog—MOS Tab
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UPLOADING REPLACEMENTS
When an object is uploaded to the Chyron MOS Server using Asset Manager, it is automatically 
assigned a GUID (Graphic Unique ID). If an object is deleted, the GUID is also deleted. 

Replacing an Existing Object
If an existing object needs to be replaced, it is best practice to upload a replacement by right-
clicking on the object and selecting Upload Replacement from the context menu (Figure 43). 

Figure 43  Upload Replacement
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The following example should make this clear.

Example: A new lower third has been created to replace the current lower third, and all new 
and existing LUCI objects should use this new message. You should select Upload 
Replacement, rather than Delete. If you delete the old object, then any LUCI objects created 
from that object will still play out with the old content. Only if Upload Replacement is used will 
all LUCI objects reflect the change. 

Important

If an object is deleted from the Asset Manager, the 
newsroom should refresh their LUCI browser to 
ensure that their LUCI browser is not offering any 
objects that are no longer available. If an image has 
been deleted from a Context using Asset Manager, and 
LUCI has not been refreshed, it is possible for the 
newsroom to preview a graphic correctly even if the 
image no longer exists.

To Replace an Existing Object:

1. Right-click on the object to be replaced.

2. Select Upload Replacement from the context menu (Figure 43). A Drop Replacement 
File Here window (Figure 44) appears.

Figure 44  Drop replacement File Here

3. Drag and drop the replacement file onto this window.
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ADDITIONAL NOTES

•  It is recommended that if different versions of Lyric are being used by the 
Playout device, the CAMIO Server, and the creation workstation, all 
content should be tested in all versions of Lyric, to ensure compatibility.

•  When creating images to be used in LUCI, it is recommended that images 
for a particular Lyric description message have the same aspect ratio to 
ensure no distortion of the replaced image.

•  For maximum use of image elements, build as many messages as possible 
with replaceable images of the same aspect ratio. With savvy use of masks 
and supporting images, one image can be used for many different style 
graphics (create an OTS image, and use it for a full screen background). 

•  Ensure that all messages with clips are checked in a back-to-back playout 
scenario, to ensure the message is created with the best clip transition 
possible.

•  The Chyron MOS Server automatically distributes messages and images 
to the appropriate playout devices. It does not distribute clips, sound files, 
unembedded images, movies, 3D textures, or fonts. These objects should 
be transferred to the same directory on the playout machines and on the 
Camio server manually. It is recommended that this content reside on all 
playout machines, in case objects are redirected to a machine they do not 
play out from normally.

•  Clips are not viewable in the LUCI Preview.

•  In order for unembedded images, movies and 3D objects to be displayed 
correctly on the Luci Preview, the files should exist on the Chyron MOS 
Server in the same location as the device where the messages were 
originally created. The location of these assets cannot be a shared drive 
but must be a physical drive with the correct drive letter.

.
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APPENDIX A: JAVA POLICY TOOL 
CONFIGURATION for LEGACY ASSET MANAGER 

To Set Java Policy:

1. Double-click on the Java Policy Tool (policytool) located in C:/program files/java/
<version number>/bin. The Policy Tool (Figure 45) is displayed.

Figure 45  Java Policy Tool

2. Click Add Policy Entry. The Policy Entry dialog (Figure 46) appears.

Figure 46  Policy Entry Dialog

3. In the CodeBase input field, enter http://<camioserver>/* (where <camioserver> is the 
name of the CAMIO server). 
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4. Click on Add Permission. From the Permission drop-down list (Figure 47), select All 
Permissions.

Figure 47  Permission Drop-down List

5. Click OK, to close the Permissions dialog. 

6. Click Done, to close the Policy Entry dialog.

7. Repeat steps 2 through 6, entering http://localhost/* in the CodeBase input field in step 
In the CodeBase input field, enter http://<camioserver>/* (where <camioserver> is the 
name of the CAMIO server). (Repeating these steps for localhost only needs to be done 
when installing Asset Manager on the Camio Server).

8. From the Policy Tool File menu, select Save As. The Save As dialog is displayed.

9. Save this file as .java.policy (remember the period in front of java) in the c:/documents 
and settings/<your login> folder. <your login> is the user name that Windows is logged 
in as.

Add the Chyron MOS server as a trusted site in the Internet settings of your browser. 

To do this:

1. From the Internet Browser menu, select Tools>Internet Options. The Internet Options 
dialog box opens.

2. Select the Security tab. Click on Trusted sites.

3. Click on Sites. The Trusted Sites dialog box is displayed.

4. Enter the following URL: http://<CAMIO_SERVER>.

5. Uncheck the Require sever verification (https) for all sites in this zone check box 
(there is no certificate for the Camioserver).

6. Click Add.

7. Close the Trusted sites and Internet Options dialogs.
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APPENDIX B: JAVA POLICY TOOL 
CONFIGURATION for NEW ASSET MANAGER
To Set Java Policy for the new Asset Manager, perform the following procedures (Launching the 
Java Policy Tool, Adding the Policy Entry, Setting Permissions, and Saving the Policy 
Entry) in the order given.

Launching the Java Policy Tool:

1. On the workstation, locate the folder containing the highest revision of Java on the 
computer (c:\program files\Java\jre1.6.x\bin). Within that folder, locate the Java policy 
tool executable, policytool.exe, and double-click on it to launch the application. See 
Figure Figure 48.

Figure 48  Java Policy Tool Executable

2. A DOS Command window will display and the Policy Tool application (Figure 49) will 
open. The Policy Tool may display multiple entries, including an entry for the Legacy Asset 
Manager of the same CAMIO. This information may stay in the Policy Tool unchanged. 

Figure 49  Policy Tool
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Adding the Policy Entry:

1. Click on Add Policy Entry to create an entry for the CAMIO server. The Policy Entry 
dialog (Figure 50) will appear. 

Figure 50  Policy Entry Dialog

2. In the CodeBase field, enter the following string: 

http://<YOURCAMIOSERVER>:8080/assetmanager/AssetUploader.jar

where <YOURCAMIOSERVER> is the name of the CAMIO server to be used (note that 
other than the name of the CAMIO server, the path is case-sensitive).
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Setting Permissions:

1. Click on Add Permission. The Permissions dialog will appear (Figure 51). The 
Permissions dialog has three fields: Permission, Target Name, and Actions that are 
set using corresponding dropdown lists. A fourth field, Signed By, requires no entry.

Figure 51  Permissions Dialog

2. Set the three fields as follows (Figure 52):

a. In the Permissions field select FilePermission from the dropdown list. This will post 
java.io.FilePermission in the text box to the right of the Permission field.

b. In the Target Name field, select <<ALL FILES>> from the dropdown list. This will 
post <<ALL FILES>> in the text box to the right of the Target Name field.

c. In the Actions field, select read from the dropdown list. This will post read in the text 
box to the right of the Actions field.

d. Press OK to close the Permissions dialog and return to the Policy Entry dialog.

e. Click Done to return to the Policy Tool.

Figure 52  Setting Permissions
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Saving the Policy Entry:

1. In the Policy Tool, select FILE>SAVE AS or FILE>SAVE (if there is an existing Java Policy 
that is being added) from the main menu.

2. In the File Save As dialog (Figure 53), navigate to c:\Documents and Settings\<USER> 
(replace <User> with the user name on the computer currently in use). The file should be 
saved as:

.java.policy

Note the period before the word java in the 
above file name.

Figure 53  Save As Dialog

3. Click on Save to save the file with the proper name; close the Save As dialog box.
51



4. The JAVA Status dialog (Figure 54) will appear to indicate the success of the file save 
operation. Click on OK to accept the modifications to the Java Policy tool.

Figure 54  Java Status

5. Click on FILE>EXIT to close the Java Policy tool. 

6. Close any open browser windows and re-launch the browser. Log into the new Asset 
Manager (http://<yourcamioserver>:8080/assetmanager ). You should now be able to 
drag assets into the drop zone and begin the process of publishing them to CAMIO.
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APPENDIX C: GLOSSARY

Term Meaning

Asset Manager Asset Manager is a Java based application that enables users to manage Chyron 
MOS Server content in a similar way that Windows Explorer is used to manage a 
computers content. Asset Manager is only compatible with Windows platforms. 
Java 1.5 (or above) and Internet Explorer are required.

Context Groups of assets (Messages, also referred to as Templates, and images), for use in 
a Chyron MOS System, are called Contexts. Individual Contexts are most com-
monly used to manage content of the same look. For example, two Contexts could 
be created to separate different look morning and evening news graphics. Con-
texts can also be used to manage users. If there is content that only specific users 
can have access to then this should also be located in a separate Context, since 
user privileges are assigned to whole Contexts.

Groups Groups make it easier to manager access rights to large numbers of users.   

LUCI Lyric Universal Control Interface

Lyric Message A Lyric message is a Template Data Message.

MOS Object A MOS object consists of a Template Data Message and metadata.

Template A Template’s technical name is Template Description Message. The Template 
Description Message is a Lyric message that contains 2D Text Template fields 
and/or 2D Object (Image) Template fields. Template Description Messages act 
as templates on which customized graphics can be quickly created on remote PCs 
and sent for playout on a Duet system.

Template Data 
Message

Created from Templates (Template Description Messages), a Template Data 
Message is a Lyric message that specifies text that is to populate specified 2D Text 
Template fields and/or 2D objects (images) that are to populate specified 2D 
Object Templates, as well as data specifying an association with a Template 
Description Message. When the Template Data Message is recalled (read), the 
associated Template Description Message is displayed. Its 2D Text Template 
fields display the text specified in the Template Data Message., as well as the 2D 
objects (images) specified in the Template Data Message.

Trustee A Trustee is a Group that has access rights to a Context. 

Users CAMIO keeps a list of Users that require access to LUCI via the newsroom com-
puter system. 
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APPENDIX D: CAMIO LEGACY ASSET MANAGER

OVERVIEW
The Legacy Asset Manager is a powerful tool in CAMIO for managing graphics and Lyric 
Templates (also referred to as assets). Assets can be viewed, sorted, edited, copied, deleted, and 
downloaded. A virtual folder hierarchy enables simple, yet sophisticated organization.

INITIAL LAUNCH of ASSET MANAGER
The initial launch of Asset Manager will install the latest version of Java, but not if Java 1.4 (or 
earlier) is already installed. The older version of Java must first be uninstalled. 

Check if there is an older version of Java installed on the client PC. 

To do this:

1. Open the Windows Control Panel. Double-click on Add or Remove Programs. The Add 
or Remove Programs dialog displays.

2. Check that the version of the Java Runtime currently installed is J2SE Runtime 
Environment 5.0 Update 4 (or later). If it is not, remove it.

To open Asset Manager:

Asset Manager must already be configured, and the Service Broker 
must be running to successfully open Asset Manager.

1. Open Internet Explorer.

2. Enter the following URL: http://camioserver:8080/CAMIO/AssetManager.html (8080 is 
the data connection port used by CAMIO and camioserver is the name of the Chyron 
MOS server). The CAMIO Server automatically loads the Java Runtime.

3. Next, set up Java to ensure Asset Manager operation. See “ADDITIONAL NOTES” on 
page 45.
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4. Click Enter or Go. The Login window is displayed (Figure 55).

Figure 55  Camio Asset Manager Login Window

5. Enter Host Name.

6. Leave Port Number as 93.

7. Enter admin in the User Name field and admin in the Password field.

8. Click OK. The Asset Manager is displayed (Figure 26).

Figure 56  Camio Asset Manager

You are now logged into a host Chyron MOS Server. If you wish to save the server(s) so you can 
automatically reconnect when you log in to the Chyron MOS Server next time, bookmark it by 
selecting File and Bookmark systems from the Asset Manager Main menu. See “File Menu” on 
page 58. 

SERVER
ICONS
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ASSET MANAGER INTERFACE
The Asset Manager Interface (Figure 57) consists of a Menu Bar, Server/Context window, Status 
Log window, and Asset Display window. These items are described below:

Figure 57  ASSET MANAGER INTERFACE

Menu Bar (Figure 57) - descriptions of the menus are as follows.

File Menu (Figure 58)

Figure 58  File Menu

MENU BAR

SERVER/CONTEXT WINDOW ASSET DISPLAY WINDOWSTATUS LOG WINDOW
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View Menu (Figure 59)

Figure 59  View Menu

Open System... Displays the New System dialog, when selected. 
Enter a CAMIO Server Host Name, User Name, 
and Password, then Click OK. to connect to a new 
system.

Bookmark System Remembers systems currently connected, when 
Asset Manager is next opened.

Reload Bookmark Reloads the bookmark.

Exit Select to exit Asset Manager.

Replications Displays the replications window that displays all replications 
on the connected servers.

Status Log Displays the Status Log.
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Asset Table Menu (Figure 60)

Figure 60  Asset Table Menu

Server/Context Window (Figure 61) - displays the various servers on the system, Context icons, 
and any Context sub-folders. See Figure 61 for a detailed view.

Figure 61  Server/Context Window

A plus sign to the left of the Context icon indicates that there are sub-folders in that Context. 
Clicking on the plus sign will expand the view and allow you to browse the sub-folders. 

When a new context is created in CAMIO, there is only a Context Icon and a Trash container 
within the context. Sub-folders for the assets used in a context are not required, however, it is 
suggested that a folder hierarchy such as:

- Messages

- Images

be created to provide a visual structure for publishing and searching for assets on the system.

Asset Display Window (Figure 57) - displays Context assets. 

Status Log Window (Figure 57) - displays the status log.

Large Icons Click to display large icons.

Select All Click to select all items.

Clear Selection Click to clear selected items.

SERVER
ICON

CONTEXT
ICON

CONTEXT
SUB-FOLDERS
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WORKING in ASSET MANAGER
ENTERING ASSETS
ENTERING ASSETS ONE at a TIME
Simply drag and drop the desired file onto the Asset Display window (Figure 57). The New Asset 
Details dialog (Figure 62) is displayed. Use this dialog to enter meaningful metadata about the 
asset in the Subject, Keywords, and Comments fields. When done entering metadata, click on 
Upload. The new asset is then uploaded to the Asset Manager, and a thumbnail image of the 
asset is displayed in the Asset Display window along with the accompanying metadata. 

Important

It is important that meaningful metadata is entered to 
facilitate searching the asset database at a later time.   
Asset Manager has a search tool that allows you to 
search for files using this metadata. The metadata is 
also used by the newsroom to conduct searches in 
LUCI.

Figure 62  New Asset Details Dialog
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ENTERING MORE THAN ONE ASSET at a TIME
To enter files:

1. Use Ctrl + click to select multiple files and drag and drop them onto the Asset Display 
Window. The New Asset Details dialog (Figure 63) is displayed. 

Figure 63  New Asset Details—Use as Template For All Files

2. Enter meaningful metadata about the files in the Subject, Keywords, and Comments 
fields.

3. Check the Use As Template For All Files checkbox (applies the metadata you enter to all 
selected files), or leave it unchecked (allows you to enter metadata separately for each of 
the selected files). 

4. Click on Upload.

5. If you did not check Use As Template For All Files, proceed to step 6. If you did check 
Use As Template For All Files click Upload. All selected files are now uploaded; you 
may now exit this procedure.

6.  When done entering metadata for the first selected file, click on Upload. 

7. Enter metadata for the next selected file. Click on Upload. Repeat step 6 and step 7 until 
all the files have been uploaded.
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STORING IMAGE FILES and LYRIC TEMPLATES
Asset Manager handles the storing of image files and Lyric Templates as follows:

Image Files
An image file will generate a thumbnail image when entered into Asset Manager. These 
thumbnail images will also be displayed in LUCI’s Image Browser when the applicable Context 
is selected.

Lyric Templates
To use Lyric templates in LUCI, they must have been previously saved with XML. See Saving 
Lyric Templates with XML, below. Asset Manager will report an error in the Status Window, if 
you try to store a .lyr file that does not have XML in it.

SAVING LYRIC TEMPLATES with XML
In order to enter Lyric templates into Asset Manager, they must have been previously saved with 
XML. To do this, save the template in Lyric. Lyric must be running on a template creation 
workstation that has the XML and MOS plug-ins installed and configured correctly.

The template creation workstation can be an offline Lyric system or a 
Duet system. The template creation workstation should not be on the 

CAMIO server. 

CONTEXTS
Clicking on a Context icon will display all the assets in the Asset Display window. A plus sign to the 
left of the Context icon (Figure 64) indicates that there are sub-folders in that Context. Clicking on 
the plus sign will expand the view and allow you to browse the sub-folders. 

Figure 64  Click to View Subfolders

CLICK TO
EXPAND
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CONTEXT SUBFOLDERS
Using Context subfolders offers a convenient way to organize different types of assets within a 
Context. It is recommended to create and name folders that match the content that will be 
uploaded.

Adding a New Folder

To add a new folder:

1. Right-click on the Context. 

2. Select New Folder from the context menu that appears. The Create Folder dialog 
appears (Figure 39). 

Figure 65  Create Folder

3. Enter the name of the new folder. 

4. Click OK.

To use Lyric templates in LUCI, they must have been previously saved with XML. Asset Manager 
will report an error in the Status window if you try to store a .lyr file that does not have XML in it.

DELETING OBJECTS
To delete an object from a Context, right-click on the object and select Delete. The object will then 
be moved into the Trash bin, and may be deleted from there. To delete the contents of the Trash 
bin, right-click on the Trash bin and select Empty Trash.

To delete an object without moving it to the Trash bin, hold down the Shift key, while performing 
the delete operation. This operation cannot be undone.
64



EDITING OBJECT PROPERTIES
Object properties can be edited once an object has been uploaded by right clicking on the object 
and selecting Properties. The Properties dialog appears with the General tab selected by 
default. See Figure 40. The Properties dialog allows edits to be made to the metadata as well as 
offering the ability to change Virtual channel assignments and snap frames. See below for detailed 
descriptions of these tabs. 

General Tab (Figure 40) - The General tab displays the Lyric message number, type of file, 
Lyric build number, and other pertinent file information including if files were saved with XML 
(see Attributes).

Figure 66  Properties—General Tab
65



Summary Tab (Figure 41) - The Summary tab provides Title, Subject, Author, Keywords, 
and Description fields that may be edited.

Figure 67  Properties Dialog—Summary Tab

MOS Tab (Figure 68) - The MOS tab provides various fields for editing.

Figure 68  Properties Dialog—MOS Tab
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UPLOADING REPLACEMENTS
When an object is uploaded to the Chyron MOS Server using Asset Manager, it is automatically 
assigned a GUID (Graphic Unique ID). If an object is deleted, the GUID is also deleted. If an 
existing object needs to be replaced, it is best practice to upload a replacement by right clicking on 
the object and selecting Upload Replacement from the context menu (Figure 43).

Figure 69  Upload Replacement

The following example should make this clear.

Example: A new lower third has been created to replace the current lower third, and all new 
and existing LUCI objects should use this new message. You should select Upload 
Replacement, rather than Delete. If you delete the old object, then any LUCI objects created 
from that object will still play out with the old content. Only if Upload Replacement is used will 
all LUCI objects reflect the change. 

Important

If an object is deleted from the Asset Manager, the 
newsroom should refresh their LUCI browser to 
ensure that their LUCI browser is not offering any 
objects that are no longer available. If an image has 
been deleted from a Context using Asset Manager, and 
LUCI has not been refreshed, it is possible for the 
newsroom to preview a graphic correctly even if the 
image no longer exists.
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